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1 ImageJ

ImageJ je volé dostupny program vyvinuty sp@leosti National Institutes of Healthdany
pro zpracovani a analyzu obrazu. Program je zaloagorogramovacim jazyce Java. ImageJ
lze spustit jako online aplikaci nebo jako stahelraiu aplikaci na pdtacich s Javou.
Stahovatelné distribuce jsou dostupné pro WinddMag OS X a Linux. Program dokaze
zobrazovat, zpracovavat, ukladat a tisknout 8-, d@2-bitové obrazy. Dokdze pracovat s
mnoha obrazovymi formaty — TIFF, GIF, JPEG, BMPCDM, FITS a RAW. Podporuje
zobrazeéni sérii obrédz/ jednom oka.

Program umi p&tat ploSné a pixelové statistiky v uzivatelem defianém vybru.
Umoziuje nefit vzdalenosti a uhly, dokaze vytiibhistogramy acarové profily, podporuje
standardni funkce zpracovani obrazu jako jsou k&gi@ aritmetické operace mezi obrazy,
manipulace s kontrastem, konvoluce, Fourierovayagabsteni, vyhlazovani, detekce hran a
medianove filtrovani.

ImageJ umi pravat geometrické transformace obrazu jako jsoérgynmetitka, rotace nebo
pieklopeni. Obraz e byt zétSen v pordru 32:1 nebo zmenSen v pém 1:32, gicemz
vSechny funkce jsou dostupnéi pibovolném faktoru z¥tSeni. Program podporuje také
zobrazeni libovolného gtu oken sotasré, omezené pouze dostupnou @ém

Prostorova kalibrace umiidje mefit rozmery objekii v jednotkach jako jsou napmilimetry.
Dostupna je takeé kalibrace hustoty nebo rozsah& Badry.

Otewena architektura ImageJ poskytuje Sirokou Hazdnost programu pomoci Java
zasuvnych modul Vlastni roz§iujici zdsuvné moduly mohou byt vytemy v editoru, ktery
je piimo sowasti programu. Rozgijici baltky umoziuji feSit libovolny problém souvisejici
se zpracovanim a analyzou obrazu.

1.1 Instalace

Aktudlni verzi ImageJ Ize stahnout na webové adtrespe/imagej.nih.gov/ij/download.html
Podrobnosti k instalaci programu na systémy Lirdac OS 9, Mac OS X a Windows jsou
dostupné na stranttp://imagej.nih.gov/ij/docs/install/

Windows

Verze ImageJ pro Windows je dostupna v 32-bit nebbibverzi s Java nebo bez. Verze 64-
bit Java vyZaduje 64-bitovou verzi Windows. VSechrgrze obsahuji ipklad& Java a
soubor ImageJ.exe.

Linux
Pro instalaci a spuSti programu ImageJ stahni soubor Linux x86 .taflgz sraZzeni zde:
http://rsb.info.nih.gov/ij/download.htrylrozbal do slozky ImageJ a spysikaz ,run’.

Napriklad:

gunzip ij123-x86.tar.gz
tar xvf ij123-x86.tar
cd | maged

./run



Na nowjSich verzich Linuxu lzeijkaz ,run‘ spustit dvojim kliknutim mySi. Tato irsace
obsahuje Sun's Java Runtime Environment 1.5 a ngextirojové kody ImageJ.

Mac OS X

Stahni ImageJ pro Mac OS X a dvakrat klikni mysSi s@ubor ,ImageJxxx.tar.gz pro
rozbaleni soubdr Zkopiruj rozbalené soubory do slozky Applicatiomséewi a zkopiruj
ImageJ nebo ImageJ64. Imagedibve 32-bit moédu s pouzitim Java 1.5, Image X4 ¥ 64-
bit médu s pouzitim Java 1.6.

Mac OS 9

Stahni a rozbal archiv pro Mac OS Ktp://rsb.info.nih.gov/ij/download.html Vytvoienou
slozku ImageJ i@sui do cilové lokace — napdo slozky Applications. Ke spuséii ImageJ
dvakrat klikni mySi na ikonu programu. Spir§t programu vyZaduje instalaci Macintosh
Runtime for Java (MRJ)

1.2 Obrazy a obrazove formaty

Digitalni obrazy jsou dvourozémé ntizky hodnot intenzity obrazovych bid(pixel)

s Sftkou a vySkou obrazu definovanouc¢pem pixeli ve snéru X (fadky) a Y (sloupce).
Pixely jsou tedy nejmensi elementarni sloZzky obrazmohou nabyvat hodnot intenzit
v rozsahu mezéernou a bilou. Charakteristiky tohoto rozsahucgbdhodnot intenzity/jas
které se vyskytuji v obraze) jsou definovany jakwdyna (bitova) hloubka obrazu a’wijf
piesnost s jakou jsou jednotlivé intenzity kddovdmyageJ pracuje €mito typy obraz:

8-bit Obrazy mohou zobrazit 256%[&tupii Sedi.

16-bit Obrazy mohou zobrazit 65 536 {Pstupii Sedi.

32-bit Obrazy mohou zobrazit 4 294 967 29&)&tupit Sedi.

RGB Barevné RGB obrazy mohou zobrazit 256 hodnderveném, zeleném a

modrém kanalu — 24-bit {¥). RGB obrazy mohou byt i 32-bitové (24-bitové
barevné obrazy s 8-bity pro kédovani alfa kanatinigdnosti).

Mezi podporované obrazové formaty v ImagelipafF, GIF, JPEG, PNG, DICOM, BMP,
PGM a FITS. Mnoho dalSich fornige podporovano s pomoci zasuvnych médul

TIFF (Tagged Image File Format) je standardni form#&deJ. Format fize byt 1-
bit, 8-bit, 16-bit, 32-bit nebo barevny RGB.

DICOM (Digital Imaging and Communications in Medicing sgtandard popularni
v oblasti medicinského zobrazovani.

FITS (Flexible Image Transport Systém) je format pienwps, sdileni a archivaci
astronomickych dat.

PGM (Portable GrayMap), PBM (Portable BitMap) a PPNor(Rble PixMap) jsou
jednoduché obrazové forméty, které pouzivaji lkaviASCII.

AVI (Audio Video Interleave) je kontejnerovy formateky miZze obsahovat data

kodovana mnoha #igoby.

1.3 Série obraz U

ImageJ dokaze zobrazit vice prostaraebocasow souvisejicich obraizv jednom oks —
ozn&uji se jako série. Jednotlivé obrazy v sériich g@atji jako fezy. V sériich se
z obrazového bodu (pixelu) stdva objemovy elemeoxdl). VSechny obrazoviezy v sérii



musi mit stejnou velikost a bitovou hloubkut§ina obrazovych funkci v ImageJ dokaze se
sériemi obrai pracovat.

Hypersérie jsou multidimenzionélni obrazy, kteréSikuji série obrai nactyii (4D) nebo gt
(5D) roznera: x (Sika), y (vysSka),z (pocet fezt), ¢ (patet kanah nebo barevnych slozek
obrazu) & (cas).

1.4 Barevné obrazy

ImageJ se zabyva barvoskolika zpisoby: pseudobarevné obrazy, RGB obrazy, RGB / HSB
série obraiz a kombinované obrazy.

Pseudobarevné obrazy

Pseudobarevny obraz je jednokanalovy Sedotonovgzof8-, 16- nebo 32-bit), kterému je
barva pifazena prosednictvim vyhledavaci tabulky LUT (Lookup Table)azdému odstinu
Sedé jsou firazeny odpovidajici hodnotiervené, zelené a modré slozky barvy tak, ze se
Sedotonovy pixel zobrazi stiplusnou barvou. Barvy v pseudobarevném obrazeisguv

s intenzitou objektu, nikoliv se skdteou barvou objektu.

Obrazy v pravych barvach

Obrazy v pravych barvach (napRGB) odpovidaji skuteym barvam objektu, tj. nap
zelend barva v RGB obraze odpovida skutezelené bagvobjektu. Typickymi detektory
barevnych obrazjsou nap. CCD¢ipy.

Barevné prostory

Barevné prostory popisuji stupnice barev, se ktegracuji systémy na zpracovani obrazu.
Protoze je lidské oko trichromatické, reprezentjSina barevnych modejednotlivé barvy
ttemi hodnotami. Matematicky tyto hodnoty (barevnénkonenty) vytvéeji trojroznerny
barevny prostor: n&pRGB, HSB, CIE Lab nebo YUV.

RGB model (Red, Green, Bldueftvena, zelena, modra) je nejpouzijanbarevny prostor.
Nicmérg jiné alternativy, jako nap HSB model (Hue, Saturation, Brightness) poskyjtsié
vyznamné vyhody i zpracovani barevné informace. V barevném prostt8®i je vlastnost
Cisté barvy popséana parametrem Hue (odstin) — geljgdnotlivé barvy. Saturation (sytost)
charakterizujecistotu barvy — kolik bilé barvy je fglano k zakladni bagv Parametr
Brightness (jas) popisuje celkovowtust barvy. Z hlediska digitalniho zpracovani clurge
pouziti barevného modelu HSB mnohdy vyhgdnnez pouziti barevného modelu RGB.
Jasova slozka HSB modelu totiziimo odpovida Sedotébnovému obrazuii Praci

s Sedotonovym obrazem je zpracovani jediného jdsokénalu mnohem jednodussi.



2 Uzivatelské rozhrani

Hlavni okno programu ImageJ je velmi jednoduchésdDije pouze panel nabidek —
piikazové menu, panel nastipjstavovytradek a indikator gibéhu. Obrazy, histogramy,

profily, apod. jsou zobrazeny v dalSich oknech. l¥gky nmeieni se zobrazuji ve vysledkové
tabulce.

The Image.] window (version 1.44l).
101112ABCDEFGH13

VJJ alo JJ JJJJ %] JEJJJJJJ e

Status bar Progress bar
1 Rectangular Selection Tool and Rounded 7 Point Tool and Multi-point Tool
Rectangular Selection Tool 8 Wand Tool
2 Oval Selection Tool, Elliptical Selection Tool 9 Text Tool
and Brush Selection Tool 10  Magnifying Glass
3 Polygon Selection Tool 11  Scrolling Tool
4  Freshand Selection Tool 12  Color Picker
5 Straight Line Selection Tool, Seemented Line A-H Macro Tools loaded from
Selection Tool, Freehand Selection Tool and StartupMacros.tzt, macros/
Arrow Tool tools/ or macros/toolsets/
6 Angle Tool 13  Toolset Switcher
Obr. 1: UZivatelské rozhrani programu ImageJ.
1 Obdélnikovy vylsr a zaobleny 7 Bod/body
obdélnikovy vykr 8 Hulka
2 Ovéalny vyker, elipsovity vykEr 9 Text
a sttec 10 Lupa
3 Mnohouhelnikovy vybr 11 Posuv
4 Vybér z volné ruky 12 Kapatko
5 Céara, sloZenéara,éara z volné A-H  Nastroje makro
ruky a nastroj Sipka 13 Tlaitko pro gepinani sad
6 Uhel nastroji

Panel nastroji (Toolbar)

Obsahuje nastroje pro vty kresleni, zoom, posun, atd. Praést nastrojové liSty obsahuje
sedm okének pro uzivatelem zvoleny libovolny ngstidald cervend Sipka v pravém

spodnim rohu &kterych ikon v nastrojové li§tzobrazuje kontextovou nabidku, ktera je
piistupnda kliknutim pravého tiitka mysi na ikonu nastroje.

Stavovyiadek (Status bar)

Kdyz prejede kurzor mysSiies obraz, zobrazi se ve stavovi&adku soiednice a intenzita
aktudlniho pixelu. Po spusiti filtrace se ve stavovéradku zobrazuje uplynul§as a rychlost
procesu (pdet zpracovanych pixelza sekundu).

Indikator pr wbéhu (Progress bar)

Je umisin v pravécasti stavovéhaadku a zobrazuje pbéh caso¥ nara@néjSi operace.
Nezobrazi se, pokud dana operace gnab vcase kratSim neziplizné jedna sekunda.
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3 Nastroje

31 Obdélnikovy vyb &[]

Pozice, §ka, vySka a po#r stran se &ghem vykreslovani zobrazuji ve stavovéadku. Lze
pouzit modifik&ni klavesy:

Shift Vybér je omezen nétverec.

Alt Sitka/vyska jsou ignény pomoci Sipek po jednom pixelu.
Ctrl Velikost vykEru je upravena podlersdu.

Ctrl+Alt Aktudlni pongr stran je zachovantimeng velikosti.

32 Zzaobleny obdélnikovy vyb & (2

Nastroj vytvdi obdélnikovy vykr se zaoblenymi rohy. Modifikai klavesy jsou stejné a
maji shodné funkce jako u nastroje obdélnikovéhmny Dvojklikem na ikonu néstroje se
zobrazi okno, ve kterém je mozné upravik@iobrysu Stroke width ), velikost zaobleni

roht (Corner diameter ) a barvu obrysu nebo vy@riStroke/Fill Color ).

33 Ovalny wb & |C
Pozice, §ka, vySka a posr stran se &ghem vykreslovani zobrazuji ve stavovéadku. Lze
pouzit modifik&ni klavesy:

Shift Vybér se stane kruhovym.

Alt Sitka/vyska jsou rnény pomoci Sipek po jednom pixelu.
Ctrl Velikost vykEru je upravena podlersdu.

Ctrl+Alt Aktualni pongr stran je zachovarvizmene velikosti.

3.4 Elipticky vb &r |2

Vlastnosti elipsy jsou danstyrmi body. Rotaci nebo z&nu velikosti Ize provéstiptazenim
bodi na hlavni ose, zému vystednosti Ize upravitigtaZzenim boilna vedlejSi ose.

3.5 Stétec @

SlouZi k upraw tvaru libovolné oblasti vyru. Kliknutim uvni¥ oblasti vylEru a tazenim
podél hranice dojde k rozéni oblasti vybru snerem ven, kliknutim va oblasti vykéru a
tazenim podél hranice dojde ke zmensSeni oblastéruybnerem dovnit. Velikost stopy
Stetce lze upravit dvojklikem na ikonu nastroje. Pezigtka, vySka a po#r stran se &ghem
vykreslovani zobrazuji ve stavovéadku. Lze pouzit modifikani klavesy:

Shift Stopa &ttce je vzdy pidana k vykgru.
Alt Stopa &ttce je vzdy odebrana od witol.
3.6 Mnohouhelnikovy vyb ér E

Vytvari vybér nepravidelného tvaru slozeny ze sériec@ke Délka Useku a uhel séhem
vykreslovani zobrazuji ve stavovéradku. K vytvdeni mnohouhelniku opakowvarklikej
mySi pro vytvéeni jednotlivych GOseek. Pro skodeni klikni do malého étveretku
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v patateénim bod (nebo dvakrat klikni mySi) a program automatickyknesli posledni
segment vykrové oblasti. Vrcholy mnohouhelniku Izeemistit tazenim mySi. Pomoci
modifikacnich klaves lze gkteré vrcholy mnohouhelniku odebrat nelimlat nove.

Shift Kliknutim na bod se s@gasnym pidrzenim klavesy Shift sefida novy bod.
Alt Kliknutim na bod se s@éasnym pidrzenim klavesy Alt se bod odstrani.

3.7 Vybér z volné ruky @

Podobr jako u mnohouhelnikového v§tu se automaticky vykresli posledni segment
vybéru. Poloha a intenzita pateniho pixelu se ¢ghem vykreslovani zobrazi ve stavovém
radku.

3.8 Cara

Délka ¢ary a jeji sklon se dhem vykreslovani zobrazuji ve stavovéadku. Lze pouZzit
modifikacni klavesy:

Shift Céara bude vertikalni nebo horizontalni.
Alt Délkacary aistane pi presunu fixni.
Ctrl P¥i pohybu se oba kona#@ry ota&eji/meni velikost kolem sedu.

3.9 Slozena c¢ara

Funguje stejéjako mnohouhelnikovy vy, Kazdé kliknuti mysi vytvid novy segmentary.
Ukon¢eni vylEru Ize provést dvojklikem mysi nebo kliknutim nalynétveretek paateiniho
bodu. Body tvéici vyker Ize premistit, odstranit neboriplat nové body. Délka a sklafary
jsou kEhem vykreslovani zobrezeny ve stavouvémku. Lze pouzit modifikani klavesy:

Shift Kliknutim na bod se s@asnym pidrzenim klavesy Shift sefida novy bod.
Alt Kliknutim na bod se s@éasnym pidrzenim klavesy Alt se bod odstrani.

3.10 Cara z volné ruky [~
Pro vytvdeni¢ary z volné ruky zvol tento nastroj a tahni mysi.

3.11 Sipka

Tento nastroj sdili stejné okénko v nastrojove ko nastrogarovéeho vybru. Dvojklikem

na ikonu nastroje se zobrazi nabidka nastaveniofr®e jedna o poznamkovy nastroj, bude
zména barvy minit barvu popedi. Stku a velikost (v pixelech) Ize nastavit posunutim
piislusnych jezdt nebo pimym zapisem zvolené hodnoty.éMt Ize také styl Sipky. Pouzit
Ize stejné modifikéni klavesy jako @&arové vylkgru.

312 Uhel

Tento nastroj umaiuje netit thel definovanimit bodi. Velikost Uhlu se zobrazichem
vykreslovani neboipkazdé zmin¢ ve stavovéntadku. Stisknutim klavesyl (Analyze ->
Measure...) se aktualni uhel zapiSe do tabulky vysledk

-10 -



3.13 Bod Vﬂ

PouZij tento nastroj pro bodovy W pctitani objeki nebo zaznam séadnic pixelu. Lze
pouzit modifik&ni klavesy:

Shift Pridrzenim klavesy Shift a klikanim mysi se k ¥ pridaji dalSi body.

Alt Pridrzenim klavesy Alt a kliknutim mysi na bod se tterbod odstrani.
PridrZzeni klavesy Alt, kliknutim a taZzenim mysii gvoleném obdélnikovém
nebo ovalném vydyu se odtrani vSechny body ve ¥yb.

Dvojklikem mysi na ikonu nastroje se zobrazi nahid&staveni.

Mark Width Pokud je ¥tSi neZ nula, zrika o stanoveném pméru bude
vykreslovana s nastavenou barvou igold. Poznamenejme, Ze
znaky poznenuji obraz. Proto je vhodjsi pracovat s kopii
obrazu. Barevné ziiky jsou dostupné pouze pro RGB obrazy.

Auto-Measure Je-li zatrzeno, kliknutim na obraz se zaznamepafice a
intenzity pixefi. Je-li Mark Width nenulové, pak pokazdé, kdyz
je méten bodovy vybr, vykresli se znika. Neni-li zatrzeno, pak
muze byt pro vykresleni zgky na pozici kazdého bodu pouzit
piikaz Edit = Draw.

Auto-Next Slice Je-li zatrzeno, ImageJ automatickiejpe na dalSi séritez.
Poznamenejme, Ze tato funkce uifig2 zvolit pouze jeden bod
na jederfez.

Add to ROI Manager Je-li zatrzeno, budou zvolené body automatickggmy do ROI
manazeru.

Label Points Je-li zatrzeno, u kazdého vybraného bodu se zblkiaelny
Stitek.

3.14 Body ’ﬁ
Nastroj body se chova podabpako nastroj bod se seasré stiS€nou klavesouShift .
KlavesaAlt miuZze byt pouZita pro odstrami bocdi. Obdob®, kdyZ pouZzijeme funkdedit 2>
Draw, budou vykresleny zi&y o priméru Mark Width . Dvojklik mySi na ikonu nastroje
spusti pikazlmage - Overlay - Add Selection .

315  Halka

Vytvéari vybér sledovanim objekt stejné barvy nebo prahovanych objekKe sledovani
objektu klikni mySi uvnit v blizkosti pravé hrany nebo vievo mimo objekt.rRdezeni hrany
objektu je hrana sledovana, dokud se nedostanemgyatmziho bodu. BHlka nemusi byt
spolehlivym néastrojem, zvlaSpro sledovani objekto Sice jednoho pixelu, pokud nejsou
prahovany Image -> Adjust -> Treshold... ). Dvojklikem mySi na ikonu néstroje se
otee nabidka nastaveni siermi mody (4-connected, 8-connected, ,Legacy’) a mosH
nastaveni tolerance.

Tolerance Hulka vybira pixely s hodnotami v rozsahu hodnotagbgniho pixelu
+ tolerance.
4-connected Pouzedtyii sousedni pixely jsou povaZzovany za sousedy dapigiedu.
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8-connected Pro kazdy pixel je uvazovano osm sousednich piXeiilka sleduje i
diagonalni linie.

Legacy V tomto modu nejsou voleny zZadné sousedni pixelg aastavena
nulova tolerance.

3.16 Text

Pouzij tento nastroj profjglani textu do obrazku. Nastroj vyivabdélnikovy vykr, ktery
obsahuje jeden nebo vitadki textu. PouZzij klavesnici pro zadani zihatextu a klavesy
Backspace nebo Delete pro smazani an&louZijEdit = Draw pro trvalé vykresleni textu
do obrazu nebémage -> Overlay -> Add Selection pro zapis textu do nedestruktivni
vrstvy prekryvajici obraz. PouZigdit - Options - Fonts... nebo dvojklik mysi na
nastroj text pro volbu stylu pisma, velikosti a@arani. Alternativl 1ze pouzitEdit >
Selection -> Properties...

3.17 Lupa W

Kliknuti mysi na obraz s timto nastrojem provedé&tani. Pravy klik mysi (nebo Alt+klik)
na obraz s timto nastrojem provede zmensSeni. AktasttSeni obrazu je ukazano v hlése
s nazvem obrazu. Dvojklikem na ikonu nastroje seanlrobrazi vfwvodni velikosti. Na
vybér je 21 moZnosti z4Seni: 3.1, 4.2, 6.3, 8.3, 12.5, 16.7, 25, 33.3,73) 100, 150, 200,
300, 400, 600, 800, 1200, 1600, 2400 a 3200 procent

Lze pouzit modifikani klavesy:

Shift P¥i zvétSeni obrazu zabrani ro&Ei okna.
Alt Provede zmenseni obrazu.

3.18 Posuv ’@

Umoziuje prochazet obraz, ktery jét8i neZ jeho okno.#PpouZziti jinych nastrdj (krome
nastroje text) Ize d@asré prepnout na nastroj posuvigrzenim mzerniku.

3.19 Kapétko

Nastavuje barvu pdpdi zkopirovanim barvy z kteréhokoliv otemého obrazu. Barvu
z obrazu lze ziskat tak&ikazemlmage -> Colors -> Color Picker... V ikon¢ nastroje
kapatko se zobrazi aktualni zvolena barvargodip Rameéek okolo ikony nastroje znazarje
aktualni barvu pozadi. Dvojklikem mysi na ikonu tndie se zobrazi okno nastaveni.
Pridrzenim modifik&ni klavesyAlt a kliknutim mySi na obraz se zvoli barva pozadi.

3.20 Prepinani sad nastroj U II

Pouzij pro pepnuti na dalSi makro nastroje ulozené ve slobegel/macros/toolsetsebo
pro navrat k vychozi s&dastrofi ImageJ/macros/StartupMacros.txt
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4 Kontextové menu

Zobrazi se p kliknuti pravého tlaitka mysi (nebo Ctrl+klinuti mysi) na okno obrailienu
muze obsahovatizné polozky.

5 Tabulka vysledk

VétSina ImageJ analyz se zobrazuje ve vysledkovéldab@iabulkové fikazy Ize vyvolat
pies funkceFile -, Edit -, Font - aResults > nebo kliknutim pravého ttitka mysi
na okno vysledk

m 1 ) Results :
Save As... (S [Label |Area [Mean  [StdDev [Mode  [Min [Max [XM YM [Perim. |+
Rename... 56 blobs.gif 8.580E2 1.973E2 3.012E1 2.320E2 1.280E2 2.480E2 1.805E2 2.302E2 1.137E2 T
Duplicate... 57 [blobs. ;'1[:3351

%X 58 blobs. A% ?.863E1 2.160E2 1.280E2 2.240E2 4.654E1 2.410E2 5.453E1
wC 59 blobs.| cut #.619E0 1.280E2 1.280E2 1.360E2 7.683E1 2.428E2 G5.657E0
60 blobs. Copy .000E0 1.280E2 1.280E2 1.280E2 1.105E2 2.465E2 2.828E0
%A 61 blobs.| Clear .468E1 1.280E2 1.280E2 2.480E2 1.790E2 2.518E2 4.238El
62 blobs. Select All 560E1 1.840E2 1.280E2 2.160E2 1.280E2 2.519E2 4.956E1
Clear Results 63 blobs. .880E1 1.360E2 1.280E2 2.480E2 2.348E2 2.522E2 3.556E1 O
Summarize 64 blobs| Clear Results .874E1 1.760E2 1.280E2 2.240E2 7.417E1 2.525E2 3.673El :
Distribution... i Summarize ) >
Set Measurements... Distribution...
Options... Set Measurements...
Rename...
Duplicate...

Obr. 2: Tabulka vysledi.

6 Logovaci okno
Slouzi k zobrazeni uzitaych informaci o aktuatnprobihajicich procesech.

AN Log

|
Y

openlmage: "zip", /samples/mitosis-test-data.zip'

mitosis-test.tif: opening
254, "NewSubfileType", value=0
256, "ImageWidth", value=256
257, "Imagelength”, value=256
258, "BitsPerSample”, value=8
262, "Photolnterp”, value=1
270, "ImageDescription”, value=194, count=10
273, "StripOffsets”, value=768
277, "SamplesPerPixel", value=1
278, "RowsPerStrip”, value=256
279, "StripByteCount", value=65536
282, "XResolution", value=297
283, "YResolution", value=305
2096, "ResolutionUnit", value=1

50838, "MetaDataByteCounts", va Cut
50839, "MetaData", value=22022] Copy
Metadata: Clear
426(61626( 336 (slice labels) Select All
______________

Obr. 3: Logovaci okno.
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7  Prikazoveé menu
Obsahuje osm nabidek:

File - Zakladni operace se soubory (at, uloZeni, vytvieni nového souboru).
Edit = Upravy a vykresleni operaci; globalni nastaveni.

Image 2> Konverze a modifikace obraxcetnt geometrickych transformaci.
Process = Zpracovani obrazu, bodové operace, filtry a atliitké operace.

Analyze - Statistick& niteni, profily, histogramy a dalSi procesy obrazavalygzy.
Plugins - Prikazy pro tvorbu, Upravu a spravu dapl (makra, skripty, pluginy).
Window -> Vybér a sprava otéenych oken.

Help 2> Aktualizace, informéni zdroje, napasda a informace o verzi programu.
8 File »
8.1 New >

Obsahuje fikazy pro vytvéeni novych obra¥ sérii obra# nebo textovych oken.iP
vytvoieni nového obrazu se otevokno nastaveni. Lze nastavit nazev soubdame), typ
obrazu Type): 8-bit-Sedotonovy, 16-bit-Sedoténovy, 32-bit-SeEthmvy nebo RGB; barevnou
vypln (Fill With): bily, ¢erny, ramp; $ku a vySku obrazuWidth /Height ) v pixelech a péet
obrazi v sérii Slices ). Vytvoirenim textového okna se vytidextovy soubor ,Untitled.txt".

8.2 Open...

Otewe soubor a zobrazi jej v novém @krSoubory musi byt formatu TIFF, GIF, JPEG,
DICOM, BMP, PGM nebo FITS nebo formatu, ktery jedporovan zasuvnymi moduly. Lze
otewit také vyhledavaci tabulkyl@t), tabulky (xls nebo.csy), vykery (.roi nebo.zip), textove
soubory (txt, .ijm, .js a.java) a dalsi.

8.3 Open Next

Zavie aktualni obraz a ot dalSi obraz (pokud existuje) v adtesRodrzenim klavesplt
se oteve predchozi obraz (pokud existuje) v adiesa

8.4 Open Samples >

Otewe ukazkoveé obrazy uloZzené na webové strance Imatj@kkové obrazy jsou vhodné
pro tvorbu, testovani a ladi maker.

8.5 Open Recent >

Nabidka obsahuje 15 naposledy @&mych soubdr. Kliknutim na nadzev se dany soubor
oteve.

8.6 Import >

8.6.1 Image Sequence...
Oteve sérii obrait ze zvoleného adreiga Obrazy mohou mitizné rozndry i formaty.
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8.6.2 Raw...
PouZij tento pikaz pro import obray které nejsou ve formatu podporovanéin
programem ImageJ.

8.6.3 LUT...
Otevird ImageJ, NIH nebo raw vyhledavaci tabulkgdkUp Table). Vyhledavaci tabulky
s koncovkoulut mohou byt oteteny také pikazemFile - Open...

8.6.4 Text Image...
Otevte tabelatorem odtkné textové soubory jako 32-bitovy obrazk&ia vyska obrazu jsou
uréeny skenovanim dokumentu a¢fiédnim slov aadki.

8.6.5 Text File...
Otevira textové soubory. Lze pouzittikaz File - Open.
8.6.6 URL..

Stahuje a zobrazuje URL forndznamych pro ImageJ. Ostatni URL adresy jsouretey
v defaultnim prohliz& uzivatele.

8.6.7 Results...
Otevird ImageJ tabulky, jiné tabulky nel#imkami oddlené textové soubory.

8.6.8 Stack From List...
Otevira série nebo virtualni série z textového soumebo URL, které obsahuji seznam cest
k obrazovym soubdm. Obrazy mohou byt viznych slozkach, ale museji byt stejného
formétu a velikosti.

8.6.9 TIFF Virtual Stack...
Otevira TIFF soubor jako virtualni sérii.

8.6.10 AVI...
Vyuziva vestainy plugin AVI Reader pro otéeni AVI souboti jako sérii nebo virtualni
sérii obraz (jeden obraz na jeden video-snimek). Lze pouké pikazFile - Open...

8.7 Close
Zavre aktivni obraz.

8.8 Close All
Zavie vSechny oteéené obrazy. Jestli jsou neuloZzené&mg) zobrazi se vystraha.

8.9 Save

UloZi aktivni obraz ve forméatu TIFF (defaultnastaveno). Pro uloZeni pouze zvolené oblasti
obrazu prové obdélnikovy vybr a pouZzij gikazImage - Duplicate...

8.10 Save As 2>

PouZij pro ulozeni aktivniho obrazu do formatu TIEHF, JPEG nebo RAW.iKkaz Ize
vyuZzit také pro ulozeni vysledkméreni, vyhledavacich tabulek nebo §in
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8.10.1 TIFF...
UloZi aktivni obraz nebo sérii do formatu TIFF. 8Sou TIFF je jediny formét, ktery
podporuje vSechny ImageJ datove typy (8-bit, 163#tbit, RGB) a je to jediny format, ktery
uklada prostorové kalibrace a kalibrace hustoty.

8.10.2 Gif...
Ulozi aktivni obraz ve formatu GIF.

8.10.3 Jpeg...
Ulozi aktivni obraz ve formatu JPEG. Upravit kualtPEG Ize fikazemEdit - Options
- Input/Output... Hodnotu kompresniho pafru Ize zvolit 0-100. Nizk& hodnota vyiVva
mensi soubory, ale s horsi kvalitou. Vysok& hodngtedti velké soubory s lepSi kvalitou.

8.10.4 Text Image...
Ulozi aktivni obraz jako tabulku kompatibilni s éddtorem od&lenym textovym souborem.
8.10.5 Zip...

Ulozi aktivni obraz nebo sérii obfagzako TIFF soubory uvnit komprimovaného ZIP
archivu.

8.10.6 Raw Data...
Ulozi aktivni obraz nebo sérii obiajako surova data bez hlakiy.

8.10.7 Image Sequence...

UloZzi sérii obra# jako sekvenci. Lze zvolit formaty BMP, FITS, GIFRPEG, PGM, PNG,
Raw, Text, TIFF nebo ZIP.

8.10.8 AVI...
Exportuje sérii obrak jako soubor AVI. Lze zvolit kompresi JPEG, PNG adbrmat bez
komprese. Stanovit Ize také frekvenci snimkpaet snimki za sekunduRrame Rate).

8.10.9 PNG...
UlozZi aktivni obraz ve formétu PNG (Portable Netk@Graphics).

8.10.10 FITS...
Ulozi aktivni obraz ve forméatu FITS (Flexible Imagensport System).

8.10.11 LUT...

Ulozi aktivni vyhledavaci tabulku obrazu (LUT) dauboru. Soubor tvd 768 byt (256 byfi
pro ¢ervenou barvu, 256 hypro zelenou barvu a 256 laypro modrou barvu).

8.10.12 Results...
Ulozi obsah vysledkového okna jako tabelatorem rébkou oddleny textovy soubor.

8.10.13 Selection...
Ulozi hranice aktualniho plosného b do souboru.

8.10.14 XY Coordinates...
Exportuje XY sowadnice ¢arového vybBru nebo hranice ploSného Wh jako dva
tabelatorem odflené sloupce textového souboru.
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8.11 Revert

Obnovi aktudlni obraz nebo sérii ohkazdisku. Vraci obrazy do posledniho uloZzenéhoustav
Jedna se oifkaz uzaveni okna bez uloZeni a naslednétopné oteveni obrazu.

8.12 Page Setup...
Umoziuje kontrolu velikosti tidiné oblasti a jina nastaveni tisku.

8.13 Print...
Vytiskne aktualni obraz. PouZifigaz Page Setup... pro nastaveni tisku.

8.14  Quit

Vyzve kuloZeni vSech neuloZenych oliraa ukori program. Program lze zév také
kliknutim na tl&itko ,zawit' v okné programu.
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9 Edit >

9.1 Undo
ZruSi poslednifikaz a vrati obraz doredchoziho stavu.

9.2 Cut
Zkopiruje obsah aktualniho Wtu obrazu do schranky a vypini ho aktualni barvozegli.

9.3 Copy

Zkopiruje obsah aktualniho wtu obrazu do schranky. Jestli neni zvolendrylakopiruje se
cely obraz. MnoZstvi kopirovanych dat je zobrazemstavovéntadku.

9.4 Copy to System
Zkopiruje obsah aktualniho wtu obrazu do systémové schranky.

9.5 Paste

Vlozi obsah schranky do aktualniho obrazu. Vkladalogaz je automaticky ozten a lze jegj
premistit tazenim mysi. Kliknutim mysi mimo Wtse dokogi vkladani obrazu.

9.6 Paste Control

Po vloZeni pouzijPaste Control menu pro kontrolu, jak se vkladany obraznese do
célového obrazu.

9.7 Clear

VymaZze obsah vysu na nastavenou barvu pozadiiikBz lze nahradit klavesami
Backspace neboDel. U série obrak se zobrazi nabidka s moZnosti vymazat obsah§rwyb
ve vSech obrazech série.

9.8 Clear Outside
Vymaze plochu mimo aktualni vipobrazu na nastavenou barvu pozadi.

9.9 Fill

Vyplni aktudlni vykr nastavenou barvou pozadi. U série obrae zobrazi nabidka
s moznosti vyplnit obsahy v§tu ve vSech obrazech série.

9.10 Draw

Vymezi aktualni vybr pomoci nastavené barvy gepdi a dky cary. U série obraz se
zobrazi nabidka s moznosti vykreslit ¥§be vSech obrazech série.

9.11 Invert
Vytvoii obraceny obraz (podobieko negativ fotografie) vydsu nebo celého obrazu.
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9.12 Selection >
Prikazy v této nabidce slouZzi k praci s ¥sjp

Original Fit Fit Fit Convex Make Create Area to Make B Tol_
rgina Spline Circle Ellipse Hull Inverse Mask Line Band. .. og;cymg
F"'-Pl‘\ ﬂf-\‘ . J’fuﬁ\ e e F ~* ’/f—":—;\\‘ -

I/ e A er :(’ b {n" . “\I I.I( \1 F’/ f II.’/ /) :( /ﬂ f ﬁ
. 1 SO beoy { N '|_ N 1 {\Y '|;\

", , )

Ty /oy~ /A /v A Iy )
e b o g g b L f S LW

Obr. 4: Vybéry.

9.13 Options >

Prikazy v této nabidce slouzi k nastaveni mndizaych Fedvoleb programu ImageJ. Nap
tlou&’ky car, nastaveni vstupa vystuf, predvolby textu, nastaveni prafjl predvolby

jednotlivych nastraj (vybery, Sipky, body, kilka, ...), nastaveni bareviqudvolby konverze,
nastaveni pa#ti, upozorgni a vystrah, atd.

-19 -



10 Image

10.1 Type >

Pouzij gikazy v této nabidce k &gni typu aktivniho obrazu nebo pro konverzi obnaayiny
typ. Konvertovat obraz Ize pouze mezi podporovanymy.

e ' = =
$ Bk iens aepn c0® KGR RGHR HSB

color color stack stack
8-bit e LS IS I, 8
16-bit [, S .S I. S
32-bit IS IS s I, S
8-hit color IS |
RGB color LS I.S —_— I, S I. S
RGB stack I
HSB stack [

I: Single images only; S: Stacks
Obr. 5: Podporované typy souhor

10.2 Adjust >

Tato nabidka obsahujefipazy pro Upravu jasu a kontrastu, prahovani &nzmvelikosti
obrazu.

10.3 Show Info...

Oteve textovy soubor sinformacemi o aktualnim obrddeobrazi DICOM a FITS se
zobrazuji také informace v hlaege souboru.

10.4 Properties...

Tento gikaz zobrazuje Sirokou Sk&lu moznosti, kterymi Ugpegavit vlastnosti obrazu nebo
sérii obrag.

10.5 Colors >
Tato nabidka obsahujéikazy pro praci s barvami a barevnymi obrazy.

10.6 Stacks 2>
Tato nabidka obsahujéikazy pro praci se sériemi obfaz

10.7 Hyperstacks -

Tato nabidka obsahujéikazy pro praci s hypersériemi obéiafj. obra#i, které maji 4 nebo 5
rozmeri (4D nebo 5D obrazy).
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10.8 Crop
OtreZe obraz nebo sérii obfagodle aktualniho vyiru.

10.9 Duplicate...

Vytvoii nové okno obsahujici kopii aktivhiho obrazu nggbéru. Pro série obrdizlze zvolit
specificky rozsah kanal (Channely, vrstve @lices a frami (Frameg, které budou
duplikovany.

10.10 Rename...
Prejmenuje aktivni obraz.

10.11 Scale...

Prikaz nmeéni velikost obrazu nebo zvoleného ¥ podle nastavenéhoéiiitkového faktoru.
K dispozici jsou d¥ vzorkovaci metody: bilinearni a bikubicka.

10.12 Transform =

Tato nabidka obsahujéikazy, které provafi geometrické transformace obraziigllopeni,
rotace, posun).

10.13 Zoom =

Tato nabidka obsahujéikazy, které kontroluji vzhled zobrazeni aktualnéiwazu (z¥tSeni,
zmenseni, originalni velikost, ...).

10.14  Overlay >

Tato nabidka obsahujéikazy pro tvorbu a praci s nedestruktivnimi vrstvafrazu. Vrstvy
se skladaji z jednoho nebo vice ¥b Sipky, ¢ary, body, text. Vrstvy mohou byt tieny
také obrazovymi vyiry.

10.15 Lookup Tables -

Tato nabidka obsahuje moZzZnosti ¥§ib barevné vyhledavaci tabulky, kteraiza byt
aplikovana na Sedotonovy obraz pro zobrazeni obrafaleSnych barvéach.
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11 Process

Prikazy v této nabidce souviseji se zpracovanim obr&etné bodovych operaci, filtr a
aritmetickych operaci mezi vice obrazy.

11.1 Smooth

Rozosti (rozmaze) aktivni obraz nebo WbFiltr nahrazuje kazdy pixel fppmérem jeho 3x3
okoli.

11.2 Sharpen

ZvysSuje kontrast a zvyramje detaily v obraze nebo v§tu, ale zvyra#uje také Sum. Filtr
pouziva nasledujici vahoveé faktory a nahrazuje kg#idel obrazu vahovanym famérem
jeho 3x3 okaoli.

-1 -1 -1
-1 12 -1
-1 -1 -1

11.3 Find Edges

Pouziva Sobél detektor ke zvyrazmy ostrych zmin intenzity (hran) v aktivnim obraze
nebo vykru. Dw konvolwni jddra o velikosti 3x3 (viz obr.) jsou pouZityvitvoreni
vertikalnich a horizontalnich derivabbrazu. Vysledny obraz je vytken kombinaci obou
dilcich obraz pomoci druhé odmocniny sttu ¢tveral.

1 2 1 1 0 —1
0 0 0 2 0 -2
-1 -2 -1 1 0 -1

11.4 Find Maxima...

Vyhledava lokalni maxima v obraze a wvyvdinarni obraz (masku) o stejné velikosti
s maximy nebo s jednou segmentovagéstici na kazdé maximum. Analyza probiha pouze
ve zvoleném vyéru nebo v celém obraze, pokud neni&ybvolen. U RGB obrazse vybira
maximum jasu. Jas je definovan jako vazeny nebazew pimér barevnych slozek (zavisi
na nastaveni Weighted RGB to Grayscale Conversion v nabidce
Edit >Options ->Conversions ).

11.5 Enhance Contrast

ZlepSuje kontrast obrazu prahovanim nebo vyrovnarngtogramu. Hkaz nezmini hodnoty
pixeli, pokud nejsou zvoleny moznostormalize Equalize HistogranmeboNormalize All n
Slices(v piipadt série obrad).

11.6 Noise -2
PouZzij tento pikaz k gidani Sumu do obrazu nebo k jeho odsirdn
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11.6.1 Add Noise
Prida nahodny Sum do obrazu nebo zvolenéhoémgbSum ma Gaussovské (normalni)
rozc&leni se sedni hodnotou 0 a sirtodatnou odchylkou 25.

11.6.2 Add Specified Noise...
Prida do obrazu Gaussovsky Sum sedii hodnotou 0 a zvolenou hodnotoué¢srdatne
odchylky.

11.6.3 Salt and Pepper
Prida do obrazu Sum typuilsa pe s nahodnym rozmi&tim 2.5% praterné pixely a 2.5%
pro bilé pixely. Fikaz pracuje pouze s 8-bitovymi obrazy.

11.6.4 Despeckle
Jedna se o medianovy filtr. Nahrazuje kazdy pixetli@nem ze 3x3 okoli pixelu. Jedna se o
¢aso¥ nara@nou operaci, protoze pro kazdy pixel ¥ musi byt vSech 9 hodnot 3x3 okoli
pixelu sé¢azeno podle velikosti a préstini hodnota je dosazena za upravovany pixel.
Medianovy filtr je vhodny pro odstrani Sumu typud a peg.

11.6.5 Remove Outliers...
Nahrazuje pixel medidnem hodnot pikel okoli, pokud se od medianu liSi vice nez zvolena
hodnota (prah). Funkce je pouZzitelna ihgmo odstraéni vypalenych pixeél nebo mrtvych
pixeli CCD kamery.

Radius Urcuje oblast (v pixelech), ze které jegidn median.

Threshold Uréuje, jak moc se musi hodnota pixelu liSit od medjaaby byla
hodnota pixelu nahrazena.

Which Outliers Urcuje jestli budou nahrazeny hodnoty pixsigtlejSich nebo tmavsich

nez okoli (median).

11.6.6 Remove NaNs...
Tento filtr nahrazuje NaN (Not-a-Number) pixely 2-Bitovém obraze medianem z okoli
pokrytého kruhovou plochou o poléni daném hodnoto®Radius Nékteré filtry v ImageJ
mohou zntit okoli NaN pixeh tim, Ze je zraini na NaN. Nkteré filtry také mohou vytuit
neplatné vzsledky v pozicich NaN pikel

11.7 Shadows =>

Prikazy v této nabidce vytygji stinové efekty s nasviceniméegm z fiznych snéri (East,
North, Northeast, Northwest, South, Southeast, Southwest, West). Frikazy
provadiji konvoluci ImageJ 3x3 funkce s obrazem.

1 2 1 —1 —2 —1 —1
0 1 0 o 1 0 _a
-1 -2 -1 1 2 1 !
[2A ™ originalsf (A Motk il AN South.sif | [AAA Ezer tif | [AAA Wint biF

2o piwals; BBt lireting LTS 6d) | JE5=254 pisale: 8-t linwemng LUTY: 64| | 256x254 pheelst B-bar [invarting LOTL & 25500 pisals) S-bit lirverting LUTS, 68| [25Ea035 8 pitel s 8-EAr [nvering LOT1: b

Original

Obr. 6: Stiny.
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11.8 Binary -

Toto menu obsahujetfifxazy pro tvorbu binarnichtérna a bild) obrdiz Defaultré se objekty
zobrazujicerné a pozadi bilé.

Summary of morphological operators (Processr Binary > submenu).

Original ~ Make Binary Erode Dilate Open Close— Outline Skeletonize
ageJ ImageJ Imagc] ImageY ImageJ Imagel Imaged Imagel
Adjust - Threshold. .. [T] Minimum... Maximum... Erode then Dilate then 1 pixel wide 1 pixel wide
(grayscale) (grayscale) Dilate Erode outline skeleton

Obr. 7: Morfologické operace.

11.8.1 Make Binary
Prevadi obraz na binarni. Prdh binarizace Ize ndstavhage - Adjust > Threshold...
Neni-li prah zvolen, Wi se automaticky na zakladhistogramu zvolené oblasti nebo celého
obrazu.

11.8.2 Convert to Mask
Prevadi obraz na binarni. Maska dau@vwacenou vyhledavaci tabulku LUT (0O bila, 255
¢ernd). Neni-li prah binarizace zvolen¢iuse automaticky.

Calculate Threshold for Each Image Paiita prah pro kazdy obraz série.
Black Background Definujecerné pozadi a bilé pgdi.
11.8.3 Erode

Odstrawuje pixely z hran objekt v binarnim obraze. PouzijFilters >Minimum...
k provedeni Sedotonové eroze na neprahovanycheiraz

11.84 Dilate
Pridava pixely ke hranam objektv binarnim obraze. Pouzifilters >Maximum...
k provedeni Sedoténoveé dilatace na neprahovanyczeth.

11.8.5 Open
Provede operaci eroze nasledovanou operaci dilaftat funkce vyhlazuje objekty a
odstrauje izolované pixely.

11.8.6 Close-
Provede operaci dilatace nasledovanou operaci .efbat® funkce vyhlazuje objekty a
vypliuje malé diry. Tato funkce je doglm o ,pomtku’, aby se odliSila od funkce
File->Close.

Original + Voronoi

Original Distance Map Ultimate Points Watershed Voronoi
+ Ultimate Points
"f"* Original (A AA oM e A"""'I";a( AP Norono 7 A Qrig,+Voroni+UEPs
200 130 pivels) B-b, 35K 200 130 precls; BE-bic (i nwarting 2l"l" 181 i | 33—} Clinvartine | 200 T80 prals ht 25k nOy‘Som alt; - n Firvarong D"\ylsnmres H-DiT; 3BF,
- E '_'_I
" : % | |
’ L AL |
' ' : . 0 . S e
[ . . L {
L ] " - .
o |l : 0 ' " 4
- v
' i - A . W £ . ' -
T B % e @A ‘ .
' . ’. .

Obr. 8: Segmentace.
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11.8.7 Outline
Vytvéii v bindrnim obraze obrysy objékb 3tce jednoho pixeluCéara je vykreslena uvitit
objekt, tj. v pogredi.

11.8.8 Fill Holes
Tento fikaz zaphuje diry v objektech zapénim pozadi.

11.8.9 Skeletonize
Opakovag odstrauje pixely z hran objektbinarniho obrazu, dokud neni dosazenottwar
Sitce jednoho pixelu (topologicka kostra).

11.8.10 Distance Map
Vytvoii v binarnim obraze mapu Euklidovskych vzdalen@DM). Kazdy pixel popedi je
nahrazen hodnotou Sedi, ktera jesama vzdalenosti pixélod nejblizSiho pixelu pozadi (pro
pixely pozadi je EDM 0). Na algoritmu EDM jsou zadmy operacdJltimate Points |,
Watershed aVoronoi . Vzdalenosti ¥tSi nez 255 jsou nastaveny na 255.

11.8.11 Ultimate Points
Vytvaii ,ultimate eroded points' (UEP) z mapy Euklidovskyzdalenosti (EDM) binarniho
obrazu. UEP jsou maxima z EDM. Na vystupu jsou bpiikazeny hodn@t EDM, ktera je
rovna polomdru nejwtSiho kruhu, jenz se vejde do binatastice se s¢dem v UEP.

11.8.12 Watershed

Segmentace povodim jetgmb automatického odini castic, které se dotykaji. Nejprve se
vypacita mapa Euklidovskych vzdalenosti (EDM) a naleziseu,ultimate eroded points’
(UEP). Poté je kazdy UEP (lokalni maximum) dilatoyfak je jen nejvice mozné — dokud
neni dosazeno hrangastice nebo hrany oblasti dalSiho (rostouciho) UBPgmentace
povodim funguje nejlépe pro hladké konvexni objektgre se filiS negekryvaji.

11.8.13 Voronoi

Rozcdtluje obraziadami bod, které maji stejnou vzdalenost ke hranicim dvojblizSich
¢astic. To znamend, Ze itka Voronoi kazd&€astice zahrnuje vSechny body, které jsou blize
k této castici nez k jakékoliv jin€astici. Pokud jsodastice jednotlivymi body, ozdajeme
proces jako ,Voronoi tessallation’.

11.8.14 Options...
Upresiuje mnoho nastaveni préikazyBinary - .

11.9 Math ->

Prikazy v této nabidcefitaji (odeitaji, nasobi, atd.) konstantu ke kazdému pixetivaio
obrazu nebo vydyu. U série obraklze zvolit, zda se operaca provede pouze na dkiivraz
nebo na vSechny obrazy série.

11.9.1 Add...

Pricita konstantu k obrazu nebo zvolené oblasti obr&za. 8-bitové obrazy jsou vysledné
hodnoty ¥tSi nez 255 nastaveny na 255. Pro 16-bitové obsmy hodnoty ¥tSi nez 65535
nastaveny na 65535.

11.9.2 Subtract...
Odetita konstantu od obrazu nebo zvolené oblasti obrBra 8- a 16-bitové obrazy jsou
vysledné hodnoty mensi nez 0 nastaveny na 0.
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11.9.3 Multiply...
Nasobi obraz nebo zvoleny Wtobrazu stanovenou realnou konstantou. Pro 8-bitdrazy
jsou vysledné hodnotyétsi nez 255 nastaveny na 255. Pro 16-bitové objsmy hodnoty
vétSi nez 65535 nastaveny na 65535.

1194 Divide...
D¢li obraz nebo zvoleny vy obrazu stanovenou reédlnou konstantou. Pokusjemidnulou
jsou ignorovany (kromh 32-bitovych obrai). Pro 32-bitové obrazy davaéldni nulou
vysledeklInfinity (nekoné&no), -Infinity (- nekoné&no) neboNaN (0/0), pokud jsou hodnoty
zdrojovych pixel kladné, zaporné nebo nulové.

11.9.5 AND...
Provadi bitovou operaci AND aduje binarni konstantu.
11.9.6 OR...
Provadi bitovou operaci OR atufe binarni konstantu.
11.9.7 XOR...
Provadi bitovou operaci XOR aduje binarni konstantu.
11.9.8 Min...
Pixely v obraze s hodnotou mensi nez stanovendduassou nahrazeny konstantou.
11.9.9 Max...

Pixely v obraze s hodnotoutgi nez stanovena konstanta jsou nahrazeny koosatant

11.9.10 Gamma...
Na kazdy pixel (p) obrazu nebo zvoleného anfbaplikuje funkci f(p) =(p/2595” x 255
kde 0.1<y=>50. Pro RGB obrazy je tato funkce aplikovdna ve vS&elh barevnych
kanalech. 16-bitové obrazy jsoiegkélovany na 255 hodnot.

11.9.11 Set...
Vyplni obraz nebo vy obrazu stanovenou hodnotou.

11.9.12 Log
Pro 8-bitové obrazy aplikuje na kazdy pixel (p) atar nebo zvoleného v§tu funkci
f(p) =In(p)*x255/In(255. Pro RGB obrazy je tato funkce aplikovana ve vs#eth

barevnych kanalech. 16-bitové obrazy jsaeSgalovany na 255 hodnot. Vyfs log,,
spa:iiva ve vynasobeni vysledku hodnot64d3431/In(  10))

11.9.13 Exp
Provede exponencialni transformaci obrazu nebcemédio vybru.

11.9.14 Square
Provede umoami obrazu nebo zvoleného .

11.9.15 Square Root
Provede druhou odmocninu obrazu nebo zvolenéhéruyb

11.9.16 Reciprocal

Vytvoii prevracené hodnoty pixielobrazu nebo zvoleného wro. Transformuje hodnotp
pixelu na hodnotd/p.
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11.9.17 NaN Background
Nastavi hodnoty neprahovanych pikgke 32-bitovém obraze na NaN (Not-a-Number)

11.9.18 Abs
Vytvoii absolutni hodnotu obrazu nebo zvolenéhauylobrazu.

11.9.19 Macro...
Tento grikaz provede aritmetickou operaci podle vzorce madauzivatelem.

11.10 FFT >

Prikazy v této nabidce prov§d zobrazeni frekvetni domény obrazu, editaci a zpracovani.
Jsou zaloZzeny na implementaci 2D rychlé Hartleydrgnsformace (FHT). Obraz ve
frekvertni domég je uloZen jako 32-bitovy stipojenim 8-bitového obrazu, ktery zobrazuje
vykonové spektrum. iftkazy v této nabidce opeuji na 32-bitovych obrazexkoliv na 8-
bitovém vykonovém spektru. VSechny ostatni Imagé&hpy ,vidi* vykonoveé spektrum.

11.10.1 FFT
Vypocita Fourierovu transformaci obrazu a zobrazi jehdkomové spektrum. Polarni
souradnice bodovych vyt budou zaznamenanyipouziti gikazuAnalyze >Measure...

11.10.2 Inverse FFT
Paita inverzni Fourierovu transformaci. Pouzité frelkee pro filtraci Ize omezit maskovou
stopou. Barva stopy udava, které frekvence budaiipo Cerna stopa (0) Zgobi, Ze budou
k filtraci pouzity pouze frekvence mimo zvolenoomi. Bila stopa (255) #gobi, Ze budou
k filtraci pouzity pouze frekvence pokryté stopou.

Power spectrum with
mask that passes low
frequencies

Power spectrum with
Original mask that filters low
frequencies

Result of inverse
transform

Result of inverse
transform

Edited power Power spectrum after
Inverse transform :
spectrum Altering

Obr. 9: Fourierova analyza.
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11.10.3 Redisplay Power Spectrum
Prepaita vykonové spektrum obrazu z jeho frekého spektra.

11.10.4 FFT Options...
Zobrazuje okno nastaveni funkci FFT.

11.10.5 Bandpass Filter...
Odstraiuje vysoké prostorové frekvence (rozmazava obranjz&é prostorové frekvence
(ode&ita rozmazany obraz). e také potl&t vodorovné nebo svislé pruhy, které byly
vytvoieny skenovanim obrazu pédcich/sloupcich.

11.10.6 Custom Filter...
Ptikaz provadi Fourierovu prostorovou filtraci akiilra obrazu s pouzitim uzivatelem zadané
prostorové domeény obrazu jako filtru. Tento obramld Fedveden na 8-bitovy. Pixely
s hodnotami O budou odpovidajici prostorové frekeeblokovany. Pixely s hodnotami 255
mohou byt pouZity vyp@et odpovidajici prostorové frekvence bez Gtlumitr By mel byt
symetricky pges sted, jinak ntize dojit ke vzniku artefakt

11.10.7 FD Math...
Ptikaz provadi korelaci, konvoluci nebo dekonvoluabd obras.

11.10.8 Swap Quadrants
Transformuje zobrazeni Fourierovy transformacermyo kde jsou nizkeé frekvence véestu
obrazu, na formu, kde jsou nizké frekvence ¢tgech rozich obrazu. ifkaz pehazuje
kvadranty I, lll a ll, IV tak, Ze body blizkoistdu jsou pemistny k okrajim a op&ng.

FFT
Original Swapped

Non-FFT
Original Swapped

I | IV |l
1II VAR |

Obr. 10: Prikaz ,Swap Quadrants'.

11.11  Filters >
Tato nabidka obsahujéané filtry (Wetrg nainstalovanychies zasuvné moduly).

11111 Convolve...
Provadi konvoluci obrazu s konvéhim jadrem, které manuamzapiSeme do textoveho pole
okna. Konvolgni jadro je matice, jejiz &d odpovida zdrojovému pixelu a ostatni prvky
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matice odpovidaji okoli (sousednim pikal) tohoto pixelu. Cilovy pixel je vygitan jako
linearni kombinace vSech pixebkoli vynasobenychifslusnym koeficientem konvainiho
jadra. Konvolgni jadro neni omezeno velikosti, ale musi éhiercovy roznér a lichy paet
sloupdi/iadki.

) - Convolver...

a Q a - -1 1 a Q 1]
a -1 1 3 a3 43 -+ -1 1]
o 4 3 3 1 -3 -3 4 0
1 3 -3 B 13 6 -3 -3 1
1 -3 1 13 24 13 A -3 1
1 3 -3 B 13 G -3 -3 1
a -1 3 -3 A 3 -3 A a
a -1 1 3 3 -3 -+ -1 1]
a Q a - -1 1 a Q 1]

' N 4 i

( Open... ) ( Save... )

™ Normalize Kernel
™ Preview

:i Cancel :( OK )

Obr. 11: Konvoluce.

11.11.2 Gaussian Blur...
Vyhlazuje obraz jeho konvoluci s Gaussovskou funi&igma je snErodatnd odchylka
Gaussovskeé funkce.

11.11.3 Median...
Odstrauje Sum v obraze tak, Ze nahrazuje kazdy pixel zabrenedianem (pro&dni
hodnotou) pixal z jeho okoli.

11.11.4 Mean...
Vyhlazuje obraz tak, Ze nahrazuje kazdy pixel obga#mérem z jeho okoli.

11.11.5 Minimum...
Tento filtr provadi Sedoténovou erozi obrazu tad,nahrazuje kazdy pixel obrazu nejmensi
(minimalni) hodnotou z jeho okali.

11.11.6 Maximum...
Tento filtr provadi Sedoténovou dilataci obrazu, taé& nahrazuje kazdy pixel obrazu riv
(maximalni) hodnotou z jeho okaoli.

11.11.7 Unsharp Mask...
Zostuje a zvyra#uje hrany od&enim (subtrakci) rozagné verze obrazu (neostra maska)
od originalu. Maskovani neostrosti @t rozmazanou kopii obrazu @egkaluje obraz pro
ziskani stejného kontrastu velkych struktur jakosseipnim obraze. Jedna se o analogii filtru
typu horni propust, ktery zdsje obraz.
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11.11.8 Variance...
Zvyraziuje hrany obrazu nahrazenim kazdého pixelu odchyfikarianci) z jeho okoli.

11.11.9 Show Circular Masks...

Vytvori sérii obras, ktera obsahujeffklady kruhovych masek pomoci fiitrMedian...,
Mean..., Minimum... , Maximum... aVariance... pro izné velikosti okoli.

11.12  Batch >

Nabidka umoiuje provést fikazy na sérii obraz bez manuélniho zsahutilazy jsou
provedeny na vSech obrazech série zvolené vstigikys Zmény provedené pomoci ,Batch’
piikazi jsou nevratné — soubory obtigsou Fepsany.

11.12.1 Measure...
Tento fikaz provadi réteni na vSech obrazech, které jsou ve zvolené slozce
11.12.2 Convert...
Prevadi a/nebo #mi velikost vice obrazze zvolené sloZky.
11.12.3 Macro...
Spusti pikazy makro pes vSechny obrazy ve zvolené sloZce.
11.12.4 Virtual Stack...

Tento gikaz povoluje manipulace s vyrtualnimi sériemi abrénag. orez obras).

11.13  Image Calculator...
Provadi aritmetické a logické operace (vybranélddigy) mezi déma obrazyi(ngl, img2).
Oba obrazy mohou byt série (musi mit stejng¢gbabraz v sérii). Obrazy nemuseji mit
stejny format ani velikost.

Source image (imgl): Destination image (émg2):

i1
—

Operator Result Operator Resule

Add:

imgl = imgl +img2

Subtract:

imgl = imgl — img2

|i E
E
Multiply: Average:
imgl = imgl x img2 [ | imgl = (imgl +img2)/2
Divide: Difference:
imgl = imgl = tmg2 irngl = |imgl — img2|
AND: Copy:
imgl = imgl Aimg2 L imgl = img2
OR: Transparent—zero
imgl = imgl Vimg2
Vi E

imgl = imgl & img2

Min:

Max:

Obr. 12: Image Calculator.
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11.14  Subtract Background...

Odstrauje hladk& spojitd pozadi v obrazech. Proces j@eal na algoritmu ,rolling ball* od
S. Sternberga.iBdstavme si 3D povrch, jehoz vySka je dana hodrigiawali obrazu. Mé se
potom kutali po zadni strapovrchu a vytvé pozadi.

11.15 Repeat Command
Znovu spousti fzdchozi provedenytikaz.

12 Analyze

Menu obsahujeifkazy uené pro statisticka &eni obrazovych dat, vykreslovani prafi
histogranti a zasuvné moduly pro obrazovou analyzu.

12.1 Measure...

Ve vybrané oblasti obrazu §itA a zobrazuje plochy, délky, ahly nebo igmnice bod.
Statistiku hodnot (gmeér, modus, medidn, minimum, maximum, &pdatnd odchylka,
stupe Sedi, integrace hustoty) lzeftat ve zvoleném ploSnérmiarovém nebo multibodovém
tvaroveé deskriptory, Spatost, apod. Ve zvolenétarovém vyksru lze paitat délky a uhly.
Pramér, standardni odchylka, atd. secfigji z hodnot pixel podél¢ary. Pro bodové vyiry
jsou zaznamenany XY stadnice. Fikaz Measure vykresli ,invazi¢h do obrazu zneky
VvV nastavené ba&popredi.

U RGB obraz se vysledky réeni p@&itaji z jasovych hodnot pixéel Jas je ziskan konverzi
hodnot: jas =dervena + zelena + modra) / 3 nebo vahéyas = 0.299 xXervena + 0.587 x
zelend + 0.114 x modra.

12.2 Analyze Particles...

Tento gikaz pdith a n&fi objekty v binarizovaném nebo prahovaném obrazgitd se
v celém obraze nebo ve zvoleném ploSnéntnybikaz skenuje obraz nebo zvoleny ¥gb
dokud nenalezne hranu objektu. Potom vyzio@rys objektu a provadidieni.

12.3 Summarize

Pro kazdy sloupec v tabulce vyslédkpaitd a zobrazi gmeér, smérodatnou odchylku,
minimum a maximum z hodnot ve sloupci.

12.4 Distribution...
Z dat ve vybraném sloupci vysledkové tabulky vytyastogram relativniclietnosti.

Parameter Stanovuje parametr ve vysledkové tabulce, kterydebu
analyzovan.

Data Points Udavé poetiadka tabulky, které budou vyhodnoceny.

Automatic Binding Je-li zvoleno, ImageJ pouzije metodu popsanou Entt&m

k odhadu optimalni 8{y histogramu. Neni-li zvoleno, Ize
hodnotuSpecify binsa pa@éateni a koncovou hodnotu rozsahu
(Rangé nastavit manuatn
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12.5 Label
Tento gikaz ozndi aktivni vykér obrazu aktualni nagfenou hodnotou. Obrys vyl a

barvou popedi/pozadi. Vybry mohou byt ozngeny, pokud na nichipdtim byla provedena
analyza Analyze Particles... nebo Measure...) a bylo speitano &zZist vybéru
(Centroig.

12.6 Clear Results
Vymaze vysledkovou tabulku a vynuluje vSechngtiai ¢itace.

12.7 Set Measurements...

Pouzij gikazy v této nabidce pro nastaveni a upraveniakigieni budou zaznamenana a
uloZzena p pouziti gikazi Analyze(Measure..., ip pouziti gikazi Measure fes ROI
manazer (ROl Manager) afippouziti pikazi Analyze(Analyze Particles... &feni je
provedeno v celém obraze nebo ve zvolenéngnaybbrazu. Pro prahované obrazyze byt
meéteni omezeno pouze na zvyrama pixely, je-li zatrzena moZnost Limit to Threghol

Dialogové okno obsahuje &skupiny voleb: prvni skupina &uje parametry gteni, které se
ulozi do tabulky vysledk druh& skupina kontrolujer@dvolby néfeni.

12.8 Set Scale

Pouzij tuto nabidku pro nastaveni prostorovéhsithm aktivniho obrazu, aby mohly byt
vysledky ngieni prezentovany v kalibrovanych jednotkach fnapm, pm, ...). Red
pouzitim gikazu je pateba provéstarovy vylkEr pro ozngeni délky, ktera odpovida znamé
vzdalenosti. Hodnota znamé vzdalenosti (Known Distq a odpovidajici jednotka (Unit of
Length) se poté zapiSe do zobrazeného okna. DestanPixels se vyplni automaticky na
zaklad velikosti zvolenéh@arového vybru. Nastaveni Pixel Aspect Ratio na hodnotu jinou
nez 1 umoituje miznou volbu ndfitka pro horizontalni a vertikalni osu — #ap00 pixeli/cm
horizontal a 95 pixel/cm vertikalrg.

12.9 Calibrate...

Pouzij tuto nabidku pro kalibraci obrazu k nastavstandard hustoty (napp standardy
radioaktivnich izotof, kalibrace optické hustoty). Pro vyitemi kalibr&ni kiivky je nutné,
aby levy sloupce obsahoval seznansfenych ptimérnych hodnot pixél a pravy sloupec
stejny p@at kalibr&nich hodnot.

Kromé 14 funkci, které mohou byt zvoleny ze seznamu Quzve Fitting...) jsou k dispozici
jese dalsi 2 funkce, které nevyzaduji zadn&eni OD standaid

Uncalibrated OD FRevadi Sedé  hodnoty 8-bitového obrazu na hodnoty
nekalibrované optické hustoty pomoci funkce OD =
log10(255/Pixel value).

Pixel Inverter Linearni funkce definovana jako Irted pixel = Bit-depth — 1 —
Pixel value, kde bitova hloubka (Bit-depth) je 2&% 8-bitové
obrazy nebo 65535 pro 16-bitové obrazy.
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12.10  Histogram

Paita a zobrazuje histogram distribuce hodnot Sedéybaaktivnim obraze nebo zvoleném
vybéru. X-ova osa reprezentuje mozné hodnoty Sedé bé@rajue), kterych niize pixel
nabyvat. Y-ova osa reprezentujetpbpixeli (Coun) pro kazdou hodnotu Sedé barvy. LUT
panel pod X-ovou osou reflektuje rozsah zobrazdméazu. Poitan je také celkovy pet
pixeli (Cound, primérna hodnota pixél (Mean, snerodatna odchylkaStd-Dey, minimum
(Min), maximum Max), modus Mode. Pokud pejedeme fes histogram mysSi, zobrazi se
vpravo dole dvojice hodnatalugCount

Histogram RGB obraz je vytvaren po transformaci RGB obrazu na Sedotonovy obraz
pomoci vzorce:Seda = ¢ervena + zelena + modra) / 3ebo je-li zvoleno vahovani
(Weighted RGB Conversionnabidce Edit(Options(Conversions...): Seda = 0.288rvena

+ 0.587 x zelena + 0.114 x modra. Pro 16-bitoveappie rozsah Sedych hodnot mezi Min a
Max rozclen na 256 dil. Pro 32-bitové obrazy Ize pet dili nastavit v zobrazeném akn

Bins Urcuje paet dili, na které se ma ro&i rozsah Sedycho hodnot
v obraze.

Use min/max Je-li zatrZzeno, Ize zvolit minimalni a maximalebzazovanou hodnotu
na X-ové ose.

Y Max Stanovuje rozsah zobrazeni Y-ové osy. Hodnota gAwtyhodnoti

rozsah na zaklachejwtsiho pdtu pixeki na dané hodnétedé barvy.

12.11 Plot Profile

Zobrazuje dvouroz#ny graf intenzit pixel podél carového nebo obdélnikového wyb.
Osa X reprezentuje vzdalenost podlily a osa Y odpovida intenzpixeli. NaN hodnoty ve
32-bitovych obrazech jsou ignorovany. Pro obdémékeybiry nebocarové vylery SirSi nez
jeden pixel se vykresli graf fiméru sloupce, kde X-ova stadnice reprezentuje vzdalenost
ve vzoleném vyéru a Y-ova sokadnice pimérnou hodnotu intenzity pixelu. Vykresleni vice
profild v jednom grafu Ize provéstiigazem Multi Plot v nabidce Analyze(Tools(ROI
Manager...

12.12 Surface Plot...

Vykresluje trojroznérné grafy intenzit pixél. Prikazy Ize pouZit pouze pro Sedotonové nebo
pseudobarevné obrazy. Nelze je vyuzit pro RGB ghraP graf je vytvéen ze zvoleného
vybéru obrazu nebo z celého obrazu. Sadaigmafvytvaena, pokud je zdrojovym obrazem
Ssérie.

12.13 Gels »

Pouzij gikazy v této nabidce k analyze jednor@mmych elektroforetickych gél FPrikazy
pouzivaji jednoduché grafické metody, kterd se jtylegtvareni Kivek pasovych profi,
vykresleni pimek prochazejicich vybranymi vrcholy aéienim vrcholovych integral
(plocha pod kivkou). Metodu nelze vyuZit pro porovnéni fpasa tiznych gelech, pokud
nejsou kalibrovany na znameé standardy.

12.14  Tools >
Tato nabidka umditije @istup k iznym zasuvnym moddain analyzy obrazu.
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12.14.1 Save XY Coordinates...
ZapiSe do textového souboru XY sadnice a hodnoty vSech pixel aktivnim obraze, které
nepati k pozadi. Pozadi je brano jako hodnota pixelulevém hornim rohu obrazu. Pro
Sedotonové obrazy se zapisuji vSechinyaodnoty pixelu (x, y, hodnota pixelu) do jednoho
fadku, oddlené mezerou. Pro RGB obrazy seiddku zapisuje ¢ hodnot (x, y,cervena,
zelen4, modra). Ratek soustavy sdadnice je nastaven ve spodnim levém rohu obrazu.
Pcatet a procentualni zastoupeni pikekteré nepdt k pozadi, se zobrazuje v logovacim gkn
pokud neni zaSkrtnuta voll&uppress Log output

12.14.2 Fractal Box Count...
Tento gikaz se pouziva k odhadu fraktalni dimenze (D) foitid obrazu. Fraktélni dimenze
(D) muze byt pouzita k greni slozitosti objeki (vaskularizace, textury, tvar btk atd.) a je
obzvlas¢ dulezitd v gipadech, kdy nelze objekty d@b popsat pomoci Euklidovskych
deskritptofi (nag. pramér, délka, apod.). #kaz paita paet boxi rostouci velikosti, které
jsou potebné pro pokryti objektu. Graf je vyttem jako logaritmicka Skala velikosti na ose X
a logaritmicka Skala @ou na ose Y. Vykreslena data jsou proloZzefimmkou. Sklon pimky
(Slopg odpovida zaporné fraktalni dimeng: = -Slope Velikost sizé (S) a p@&et ,count
(C) jsou zobrazeny v tabulce vyslédk

12.14.3 Analyze Line Graph
ImageJ nmiZze byt pouzit pro obnoveni numerickych dat skenétarkivkového grafu.

12.14.4 Curve Fitting...
Tento jednoduchy nastroj umage prolozeni XY dat mnohaiznymi funkcemi. Lze vybrat
14 dostupnych funkci z nabidky nebo Ize zapsatnildankce. Do grafu vstupnich dat je po
provedeni fikazu zakreslenativka prolozené funkce.

Function Formula Comments

Straight Line Yy =a-+ br cf. Pixel Inverter (Calibrate...)
274 Degree Polynomial y—a-+br+ ex?

3" Degree Polynomial y—a+br+ ez + dz®

1*" Degree Polynomial y=a+br+ca?+dzd +ext

5" Degree Polynomial y=a+br+cx?+da® +ext + fr® Via the *User-defined* option

Exponential y=a x eb®

Power y = azx®

Log y = a % In(bx)

Gamma Variate y—ax (r—Hb)°x e~ 57"

Rodboard y = %{—] [35]

Exponential with Offset 3y =a x e~ ¥ L ¢

Gaussian y=a+(b—a)x 1_%—’__1 [35]

Exponential Recovery y—=ax(l— e~y + ¢ cf. FRAP Profiler plugin

Obr. 13: Curve Fitting.
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12.14.5 ROI Manager...
ROI (Region of Interest) manaZer je néstroj procpsavice zvolenymi vyry v obraze.
Vybéry mohou byt viiznych pozicich obrazu, wiznych obrazech sérii obraznebo i
v riznych obrazech. Podporovany jsou vSechny typynyb Wetné bodovych,carovych a
textovych.

12.14.6 Scale Bar...
Vklada do obrazu #fitko velikosti.

Width Udéava délku rritka v kalibrovanych jednotkach.

Height Udava tlougku nxftitka v pixelech.

Font Size Nastavuje velikost pisma pro popiskyiitka.

Color Nastavuje barvu pisma.

Background Uréuje barvu pozadi textoveho oknatiika.

Location Uréuje polohu vlozZeni titka do obrazu.

Bold Text/Serif Font Urcuje, jestli bude pismo taé (Bold) nebo patkové (Serif).

Hide Text Je-li zvoleno, zobrazi se pouzétitko bez popisku.

Overlay Je-li zvoleno, réritko se do obrazu vlozi jako nova vrstva. Neni-

li zvoleno, je m&fitko vloZzeno pimo do obrazu.

12.14.7 Calibration Bar...
Vytvari RGB kopii aktualniho obrazu a vklada do obrazietay Skalovany kalibgai panel.

Location Uréuje polohu vlozeni kalibtmiho panelu do obrazu.

Fill Color Definuje barvu pozadi textového pole kalitm#no panelu.

Label Color Uréuje barvu textu.

Number of Labels Nastavuje celkovy get zobrazovanych hodnot v popisku.

Decimal Places Nastavuje pé&et desetinnych mist zobrazovanych v popisku.

Font Size Nastavuje velikost pisma. Pismo se zobrazidyestli je
zvolena moznodBold Text

Zoom Factor Uréuje zwtSeni celého pole kalib¥aiho panelu. Hodnota mensi

nez 1 udava zmenseni.

13 Plugins =

Obsahuje fikazy pro praci se zasuvnymi moduly.

14 Window =

Tato nabidka obsahuj&yii ptikazy a seznam vSech ofemych oken programu ImageJ.
Aktualné aktivni obraz ma vedle svého nazvud&aa Pro aktivaci ufitého okna st&é vybrat
nazev tohoto okna v seznamu a odkliknout.

14.1 Show All
Zviditelni vSechny okna souvisejici s programemdaia
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14.2 Put Behind

Zobrazi dalSi otaeny obraz. Opakovanym stifim klavesyTab se opakovahpiepina mezi
vSemi otevenymi obrazovymi okny. Sti&ti klavesyEnter na kterémkoliv obrazeipsune
do pogedi hlavni okno programu ImageJ.

14.3 Cascade

Premisti vSechny otégné obrazy na levou stranu obrazovky, navzajemige sobé mirne
posune a zobrazi je v faali, ve kterém jsou B&zeny v seznamu na konci této nabidky.

14.4 Tile

Zmensi vSechna ot&ana obrazova okna a posklada je tak, aby se veSlabrazovku a
vzajemr se nepekryvala.

15 Help =

Nabidka obsahujefikazy pro zobrazeni nap&dy, informaci o verzi programu, instalaci
aktualizaci, apod.
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